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cfMesh 

• 八分木法によるメッシュ生成 

• 最大セルサイズを基準とした細分化を実施 

• STL表面や基礎形状で細分化領域を指定できる 

• 八分木法により指定領域はセルサイズを下回る大きさまで細分化され
る 

• STL表面に適合するようにメッシュを生成 

• STL表面に境界層挿入できる 

• 一括挿入も可能 

• STL領域毎に指定することも可能 

http://ja.wikipedia.org/wiki/%E5%85%AB%E5%88%86%E6%9C%A8 
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http://ja.wikipedia.org/wiki/%E3%83%95%E3%82%A1%E3%82%A4%E3%83%AB:Octree2.png


cfMeshのダウンロード 

http://www.c-fields.com/technical-area/downloads 
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cfMeshのインストール 

cfMesh-v1.0を展開 

cfMesh-v1.0フォルダー内のAllwmakeを端末内で実行 

※OpenFOAM-2.3.0 

cfMeshのtutorials 
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cartesian2DMesh/hatOctree 

maxCellSize 0.01; 

 

surfaceFile "geom.fms"; 

 

boundaryLayers 

{ 

    nLayers         6; 

    thicknessRatio  1.2; 

} 

Please run cartesian2DMesh to generate a 2D mesh. 

meshDict 
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tetMesh/cutCubeOctree 

surfaceFile "geom1.stl"; 

 

maxCellSize 0.2; 

 

boundaryCellSize 0.1; 

 

minCellSize 0.1; 

 

localRefinement 

{ 

    patch0000 

    { 

        cellSize  0.05; 

    } 

    patch0007 

    { 

        cellSize  0.05; 

    } 

} 

Please run tetMesh to generate a tetrahedral mesh.  

meshDict 
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tetMesh/socketOctree 
Please run cartesianMesh or tetMesh to generate te volume mesh.  

boundaryCellSize 1.5; 

keepCellsIntersectingBoundary 1; 

maxCellSize 3; 

minCellSize 0.375; 

removeGluedMesh 0; 

surfaceFile "socket.fms"; 

 

boundaryLayers 

{ 

    maxFirstLayerThickness 0.5; 

    nLayers 3; 

    thicknessRatio 1.2; 

 

    patchBoundaryLayers 

    { 

 

        patch7 

        { 

            allowDiscontinuity 0; 

            maxFirstLayerThickness 0.5; 

            nLayers 4; 

            thicknessRatio 1.1; 

        } 

    } 

} 

 

localRefinement 

{ 

 

    patch15 

    { 

        additionalRefinementLevels 1; 

    } 

 

    subset1 

    { 

        cellSize 1.5; 

    } 

 

    subset2 

    { 

        cellSize 1.5; 

    } 

} 

meshDict 
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tetMesh/socketOctree 
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cartesianMesh/asmoOctree 
Please run cartesianMesh to generate the mesh 

surfaceFile "geom.stl"; 

 

maxCellSize 0.2; 

 

boundaryCellSize 0.025; 

 

minCellSize 0.0125; 

 

localRefinement 

{ 

    defaultFaces0006 

    { 

        cellSize 0.005; 

    } 

    defaultFaces0007 

    { 

        cellSize 0.0025; 

    } 

    defaultFaces0009 

    { 

        cellSize 0.0025; 

    } 

} 

meshDict 
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cartesianMesh/bunnyOctree 

surfaceFile "bunnyWrapped.stl"; 

 

maxCellSize 30.0; 

 

boundaryCellSize 7.5; 

 

objectRefinements 

{ 

    ear1 

    { 

        cellSize 3.75; 

        type cone; 

        p0   (-100 1873 -320); 

        radius0  200; 

        p1   (-560 1400 0); 

        radius1   200; 

    } 

    ear2 

    { 

        cellSize 3.75; 

        type cone; 

        p0   (-650 1873 -620); 

        radius0  200; 

        p1   (-670 1300 0); 

        radius1  200; 

    } 

    tail 

    { 

        cellSize 3.75; 

        type box; 

        centre  (500 500 150); 

        lengthX  100; 

        lengthY  150; 

        lengthZ  200; 

    } 

    insideTheBody 

    { 

        cellSize 3.75; 

        type sphere; 

        centre  (0 700 0); 

        radius  50; 

    } 

    muzzlePiercing 

    { 

        cellSize 3.75; 

        type line; 

        p0      (-750 1000 450); 

        p1      (-750 1500 450); 

    } 

} 

This tutorials demonstrates the usage of primitive refinement sources 

meshDict 
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cartesianMesh/bunnyOctree 
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cartesianMesh/intakePortOctree 

surfaceFile "geom2.stl"; 

 

maxCellSize 10; 

 

boundaryCellSize 1.25; 

 

minCellSize 2.0; 

 

localRefinement 

{ 

    patch001 

    { 

        cellSize 0.625; 

    }  

    patch002 

    { 

        cellSize 0.625; 

    }  

    patch003 

    { 

        cellSize 0.625; 

    }  

    patch004 

    { 

        cellSize 0.625; 

    }  

 patch005 

    { 

        cellSize 0.625; 

    }  

    patch006 

    { 

        cellSize 0.625; 

    }  

    patch007 

    { 

        cellSize 0.625; 

    }  

    patch008 

    { 

        cellSize 0.625; 

    }  

} 

meshDict 
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cartesianMesh/sBendOctree 
The exmaple demonstrates usage of subsets for refinement, and how to set up boundary layer properties. To generate the 

mesh please run cartesianMesh or tetMesh. 

maxCellSize 0.1; 

 

surfaceFile "sBend.fms"; 

 

boundaryLayers 

{ 

    nLayers 1; 

 

    patchBoundaryLayers 

    { 

 

        walls 

        { 

             nLayers 3; 

             thicknessRatio 1.2; 

        } 

    } 

} 

 

localRefinement 

{ 

 

    refFine 

    { 

        cellSize 0.025; 

    } 

 

    walls 

    { 

        cellSize 0.05; 

    } 

} 

5( 

object 

wall  

inlet 

patch  

outlet 

patch  

symm 

symmetryPlane  

walls 

wall) 

5( 

object 

wall  

inlet 

patch  

outlet 

patch  

symm 

patch 

walls 

wall) 

sBend.fmsファイルを変更 

meshDict 
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cartesianMesh/sawOctree 
Please run cartesianMesh to generate the mesh. 

surfaceFile "sav1.stl"; 

 

maxCellSize 0.25; 

 

boundaryCellSize 0.125; 

meshDict 

numberOfSubdomains  4; 

decomposeParDict 

#!/bin/sh 

# Source tutorial run functions 

. $WM_PROJECT_DIR/bin/tools/RunFunctions 

 

runApplication preparePar 

runParallel cartesianMesh 4 

runParallel checkMesh 4 

#runApplication reconstructParMesh -zeroTime 

runApplication reconstructParMesh -constant -fullMatch 

Allrun 

Tutorialsそのままでは動かない 

14 



本日の演習内容 

• GeometryからcfMesh作成 

• 表面メッシュ作成したのちcfMesh作成 

• 境界層の作成 

• 部分的なセルサイズの指定 

• 欠けた形状のメッシュ作成 
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演習1 Primitivesによるモデル作成 
①XY平面を底面基準とし、Z軸を中心軸とする半径50mm、高さ50mmの円柱を作成する。 

（ソリッドモデルA） 

②座標値(0,0,50)を中心とする半径40mmの球形状を作成する。（ソリッドモデルB） 

③円柱（ソリッドモデルA）と球（ソリッドモデルB）を組み合わせる。 
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演習1 Primitivesによるモデル作成 

New Entity>Primitives>Cylinder 

名前は任意 

連続して作成する場合はApply 

オブジェクトブラウザに追加される 

表示/非表示切り替え 

円柱の作成 

座標原点に作成 

①XY平面を底面基準とし、Z軸を中心軸とする半径50mm、高さ50mmの円柱を作成する。 

（ソリッドモデルA） 
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演習1 Primitivesによるモデル作成 

作成中 

完成 
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演習1 Primitivesによるモデル作成 

New Entity>Basic>Point 

点の作成 

②座標値(0,0,50)を中心とする半径40mmの球形状を作成する。（ソリッドモデルB） 
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演習1 Primitivesによるモデル作成 

New Entity>Primitives>Sphere 

球の作成 

点と半径を指定して作成 

矢印を選択するとグラフィックウインドウまたはオブジェクトブラウザから選択可能 

②座標値(0,0,50)を中心とする半径40mmの球形状を作成する。（ソリッドモデルB） 
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演習1 Primitivesによるモデル作成 
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演習1 Primitivesによるモデル作成 

Operations>Boolean>Cut 

球の作成 

22 



演習1 Primitivesによるモデル作成 
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演習1 グループの作成 

New Entity>Group>Create 

グループの作成 

名前は任意 

指定のフェースを選択 

フェースをグループ化 
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演習1 グループの作成 

作成中 

選択するとハイライトされる 
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演習1 グループの作成 

low up 

hole side 

グループの作成 
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演習1 geometryの出力 
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File>Export 

geometryの出力 
グループを選択した状態にする 

STL ASCII Filesを選択 

Cut_1と各サーフェスグループを出力 



演習1-1 Cut_1のcfMesh作成 

/*--------------------------------*- C++ -*----------------------------------*¥ 

| =========                 |                                                | 

| ¥¥      /  F ield         | cfMesh: A library for mesh generation          |  

|  ¥¥    /   O peration     |                                                | 

|   ¥¥  /    A nd           | Author: Franjo Juretic                         |  

|    ¥¥/     M anipulation  | E-mail: franjo.juretic@c-fields.com            | 

¥*---------------------------------------------------------------------------*/ 

 

FoamFile 

{ 

    version   2.0; 

    format    ascii; 

    class     dictionary; 

    location  "system"; 

    object    meshDict; 

} 

 

// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * // 

 

maxCellSize        2;  

 

surfaceFile        "Cut_1.stl";  

 

// ************************************************************************* // 

StlファイルとmaxCellSizeを指
定するのみでメッシュ作成可能 

system/mesh.Dict 

$cartesianMesh 

Cut_1.stl 
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演習1-1 Cut_1のcfMesh作成 

Create time 

 

Create polyMesh for time = 0 

 

Time = 0 

 

Mesh stats 

    points:           42707 

    internal points:  31825 

    faces:            116932 

    internal faces:   106052 

    cells:            37164 

    faces per cell:   6 

    boundary patches: 1 

    point zones:      0 

    face zones:       0 

    cell zones:       0 

 

Overall number of cells of each type: 

    hexahedra:     37164 

    prisms:        0 

    wedges:        0 

    pyramids:      0 

    tet wedges:    0 

    tetrahedra:    0 

    polyhedra:     0 

 

Checking topology... 

    Boundary definition OK. 

    Cell to face addressing OK. 

    Point usage OK. 

    Upper triangular ordering OK. 

    Face vertices OK. 

    Number of regions: 1 (OK). 

 

Checking patch topology for multiply connected surfaces... 

    Patch               Faces    Points   Surface topology                   

    solid               10880    10882    ok (closed singly connected)       

 

Checking geometry... 

    Overall domain bounding box (-49.9999 -49.9999 -3.76233e-28) (49.9998 49.9999 50) 

    Mesh (non-empty, non-wedge) directions (1 1 1) 

    Mesh (non-empty) directions (1 1 1) 

    Boundary openness (-5.16849e-17 3.7172e-17 -4.65867e-17) OK. 

    Max cell openness = 3.31525e-16 OK. 

    Max aspect ratio = 2.38403 OK. 

    Minimum face area = 1.03424. Maximum face area = 5.4622.  Face area magnitudes OK. 

    Min volume = 1.9871. Max volume = 10.035.  Total volume = 256821.  Cell volumes OK. 

    Mesh non-orthogonality Max: 20.1503 average: 3.31061 

    Non-orthogonality check OK. 

    Face pyramids OK. 

    Max skewness = 0.493938 OK. 

    Coupled point location match (average 0) OK. 

 

Mesh OK. 

 

End 

$checkMesh 
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演習1-1 Cut_1のcfMesh作成 

ポリヘドラルメッシュの表示 

特徴線が抽出されない 
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演習1-2 特徴線ありのcfMesh作成 

surfaceFeatureEdges -angle 10 Cut_1.stl Cut_1.fms 

 $surfaceFeatureEdges -help 

 

Usage: surfaceFeatureEdges [OPTIONS] <input surface file> <output surface file> 

options: 

  -angle <scalar> 特徴線の抽出角度 

  -case <dir>       specify alternate case directory, default is the cwd 

  -noFunctionObjects 

                    do not execute functionObjects 

  -srcDoc           display source code in browser 

  -doc              display application documentation in browser 

  -help             print the usage 

Stlファイルから特徴線を抽出し*.fmsファイルへ変換する 

Stlファイル名 fmsファイル名 
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演習1-2 特徴線ありのcfMesh作成 

--> FOAM FATAL ERROR:  

Cannot construct the quadric surface for point 

(2.44921e-15 -5.99864e-31 10) because the normal 

does not exist! 

This indicates that the input surface mesh is of poor 

quality 

 

    From function template<class ListType> 

inline quadricFitting::quadricFitting(const point& 

origin, const vector normal, const ListType& 

otherPoints) 

    in file lnInclude/quadricFittingI.H at line 227. 

Stlの品質が悪くcfMeshではメッシュ作成ができない 

meshDict内のCut_1.stlをCut_1.fmsに変更 
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演習1-2 特徴線ありのcfMesh作成 
各サーフェスグループの*.stlファイルを修正する 

solid 

 facet normal -0.000000e+00 -0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  4.823178e+01  1.317936e+01  0.000000e+00 

     vertex  4.860115e+01  1.174430e+01  0.000000e+00 

     vertex  4.736632e+01  1.601349e+01  0.000000e+00 

   endloop 

 endfacet 

 facet normal -0.000000e+00 -0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  4.782005e+01  1.460284e+01  0.000000e+00 

     vertex  4.823178e+01  1.317936e+01  0.000000e+00 

     vertex  4.736632e+01  1.601349e+01  0.000000e+00 

   endloop 

 endfacet 

・ 
・ 
・ 
 facet normal  0.000000e+00  0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  5.913659e+00  4.964905e+01  0.000000e+00 

     vertex  1.174430e+01  4.860115e+01  0.000000e+00 

     vertex  1.317936e+01  4.823178e+01  0.000000e+00 

   endloop 

 endfacet 

endsolid 

solid low 

 facet normal -0.000000e+00 -0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  4.823178e+01  1.317936e+01  0.000000e+00 

     vertex  4.860115e+01  1.174430e+01  0.000000e+00 

     vertex  4.736632e+01  1.601349e+01  0.000000e+00 

   endloop 

 endfacet 

 facet normal -0.000000e+00 -0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  4.782005e+01  1.460284e+01  0.000000e+00 

     vertex  4.823178e+01  1.317936e+01  0.000000e+00 

     vertex  4.736632e+01  1.601349e+01  0.000000e+00 

   endloop 

 endfacet 

・ 
・ 
・ 
 facet normal  0.000000e+00  0.000000e+00 -1.000000e+00 

   outer loop 

     vertex  5.913659e+00  4.964905e+01  0.000000e+00 

     vertex  1.174430e+01  4.860115e+01  0.000000e+00 

     vertex  1.317936e+01  4.823178e+01  0.000000e+00 

   endloop 

 endfacet 

endsolid 

ファイル名を追加（patch名になる） 

修正した*.stlファイルをマージする 
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STLファイルをマージするスクリプト 

#!/bin/sh  

 

files="*.stl"  

for filepath in ${files}  

do  

  filename=`basename $filepath .stl`  

sed -i -e "1s/solid/solid $filename/" $filename.stl  

 

  echo $filename  

done  

 

cat *.stl > mesh.stl  

stl_merge 

 

 

ディレクトリ内にあるstlファイルを検出 

検出したstlファイルの数分ループを回す 

Stlファイル名を取得 

文字列”solid”を検索し”solid ファイル名”

に置き換える 

 

 

 

 

Stlファイルをマージし一つのmesh.stl

ファイルにする 
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演習1-2 特徴線ありのcfMesh作成 

/*--------------------------------*- C++ -*----------------------------------*¥ 

| =========                 |                                                | 

| ¥¥      /  F ield         | cfMesh: A library for mesh generation          |  

|  ¥¥    /   O peration     |                                                | 

|   ¥¥  /    A nd           | Author: Franjo Juretic                         |  

|    ¥¥/     M anipulation  | E-mail: franjo.juretic@c-fields.com            | 

¥*---------------------------------------------------------------------------*/ 

 

FoamFile 

{ 

    version   2.0; 

    format    ascii; 

    class     dictionary; 

    location  "system"; 

    object    meshDict; 

} 

 

// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * // 

 

maxCellSize        2;  

 

surfaceFile        "Cut_1.stl";  

 

// ************************************************************************* // 

system/mesh.Dict 

Cut_1.stl 
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演習2 表面メッシュの作成 
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メッシュを選択した状態で右クリック 



演習2 表面メッシュの作成 
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演習2 表面メッシュの作成 
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演習2 メッシュのグループ化 

39 

Mesh>Create Group 

グループの作成 

色は任意 



演習2 メッシュのグループ化 
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演習2 メッシュの出力 
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File>Export>STL file 

メッシュの出力 
メッシュを選択した状態にする 

Mesh_1と各サーフェスグループを出力 



演習2 Mesh_1のcfMesh作成 

$surfaceFeatureEdges -angle 10 Mesh_1.stl Mesh_1.fms 

$cartesianMesh 

FoamFile 

{ 

    version   2.0; 

    format    ascii; 

    class     dictionary; 

    location  "system"; 

    object    meshDict; 

} 

 

// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * // 

 

maxCellSize        2;  

 

surfaceFile        "Mesh_1.fms";  

Mesh_1.stl 
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演習3 境界層の作成 

maxCellSize        10;  

 

minCellSize 2.5;  

 

surfaceFile        "mesh.fms";  

 

boundaryLayers  

{  

 

    patchBoundaryLayers  

    {  

 

        side 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

 

        hole 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

    }  

}  

表面メッシュを作成した各フェイスのstlファイルをマージ 

$surfaceFeatureEdges -angle 10 mesh_1.stl mesh_1.fms 

$cartesianMesh 
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meshDict 
maxCellSize        10;  

 

minCellSize 2.5;  

 

surfaceFile        "mesh.fms";  

 

boundaryLayers  

{  

 

    patchBoundaryLayers  

    {  

 

        side 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

 

        hole 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

    }  

}  

最大セルサイズ 

最小セルサイズ 

fmsファイル名 

境界層第1層の最大サイズ 

層数 

成長率 
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演習4 部分的なセルサイズ指定 
maxCellSize 10;  

 

minCellSize 2.5;  

 

surfaceFile        "mesh.fms";  

 

localRefinement  

{  

 

    low 

    {  

        cellSize 2;  

//       additionalRefinementLevels 1;  

    }  

} 

 

objectRefinements  

{  

    area1 

    {  

        cellSize 1.25;  

        type box;  

        centre  (0 0 0);  

        lengthX  20;  

        lengthY  20;  

        lengthZ  20;  

    }  

} 

localRefinement, objectRefinements無し  
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演習5 欠けた形状のメッシュ作成 

maxCellSize        10;  

 

minCellSize 2.5;  

 

surfaceFile        "mesh.fms";  

 

boundaryLayers  

{  

 

    patchBoundaryLayers  

    {  

 

        side 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

 

        hole 

        {  

             maxFirstLayerThickness        10;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

    }  

}  
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演習6 snappyHexMeshとの比較 

チュートリアル内のiglooWithFridgesを./Allrunで実行 

表面メッシュを抽出 

$foamToSurface -latestTime mesh.stl 

 

iglooWithFridgesをsnappyHexMeshとｃｆMeshで比較する 

maxCellSize        0.5;  

surfaceFile        "mesh.stl";  

boundaryLayers  

{  

    patchBoundaryLayers  

    {  

        twoFridgeFreezers_seal_0  

        {  

             maxFirstLayerThickness        0.1;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

        twoFridgeFreezers_herring_1  

        {  

             maxFirstLayerThickness        0.1;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

    }  

}  

localRefinement  

{  

    igloo  

    {  

        cellSize        0.25;  

//        additionalRefinementLevels        1;  

    }  

        twoFridgeFreezers_seal_0  

    {  

        cellSize        0.125;  

//        additionalRefinementLevels        2;  

    }  

        twoFridgeFreezers_herring_1  

    {  

        cellSize        0.125;  

//        additionalRefinementLevels        2;  

    }  

}  
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演習6 snappyHexMeshとの比較 

snappyHexMesh cfMesh 
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演習6 snappyHexMeshとの比較 
Mesh stats 

    points:           17644 

    faces:            45510 

    internal faces:   40456 

    cells:            13942 

    faces per cell:   6.16597 

    boundary patches: 4 

    point zones:      0 

    face zones:       0 

    cell zones:       0 

 

Overall number of cells of each type: 

    hexahedra:     12503 

    prisms:        128 

    wedges:        0 

    pyramids:      280 

    tet wedges:    0 

    tetrahedra:    112 

    polyhedra:     919 

    Breakdown of polyhedra by number of faces: 

        faces   number of cells 

            6   176 

            7   71 

            8   20 

            9   458 

           12   114 

           15   61 

           18   19 

Mesh stats 

    points:           14257 

    faces:            33693 

    internal faces:   30195 

    cells:            9998 

    faces per cell:   6.39008 

    boundary patches: 9 

    point zones:      0 

    face zones:       0 

    cell zones:       0 

 

Overall number of cells of each type: 

    hexahedra:     6911 

    prisms:        208 

    wedges:        0 

    pyramids:      0 

    tet wedges:    12 

    tetrahedra:    0 

    polyhedra:     2867 

    Breakdown of polyhedra by number of faces: 

        faces   number of cells 

            4   397 

            5   168 

            6   702 

            7   362 

            8   40 

            9   962 

           11   15 

           12   99 

           14   1 

           15   121 

snappyHexMesh cfMesh 
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演習6 snappyHexMeshとの比較 
Checking patch topology for multiply connected surfaces... 

                   Patch    Faces   Points                  Surface topology 

                    maxY        0        0                        ok (empty) 

                    minX        0        0                        ok (empty) 

                    maxX        0        0                        ok (empty) 

                    minY        0        0                        ok (empty) 

                  ground      830      993  ok (non-closed singly connected) 

                    maxZ        0        0                        ok (empty) 

                   igloo     1276     1649  ok (non-closed singly connected) 

    twoFridgeFreezers_seal_0      800      941  ok (non-closed singly 

connected) 

    twoFridgeFreezers_herring_1      592      625  ok (non-closed singly 

connected) 

 

Checking geometry... 

    Overall domain bounding box (-1.00389 -1.00395 0) (7.00389 7.00395 4) 

    Mesh (non-empty, non-wedge) directions (1 1 1) 

    Mesh (non-empty) directions (1 1 1) 

    Boundary openness (3.52436e-17 5.92793e-17 -5.43521e-16) OK. 

    Max cell openness = 3.20833e-16 OK. 

    Max aspect ratio = 11.3868 OK. 

    Minimum face area = 0.000490601. Maximum face area = 0.280257.  

Face area magnitudes OK. 

    Min volume = 2.1449e-05. Max volume = 0.143679.  Total volume = 

129.524.  Cell volumes OK. 

    Mesh non-orthogonality Max: 51.809 average: 14.8515 

    Non-orthogonality check OK. 

    Face pyramids OK. 

    Max skewness = 3.42668 OK. 

    Coupled point location match (average 0) OK. 

 

Mesh OK. 

Checking patch topology for multiply connected surfaces... 

                   Patch    Faces   Points                  Surface topology 

                  ground     1326     1452  ok (non-closed singly connected) 

                   igloo     2228     2273  ok (non-closed singly connected) 

    twoFridgeFreezers_seal_0      750      769  ok (non-closed singly connected) 

    twoFridgeFreezers_herring_1      750      769  ok (non-closed singly 

connected) 

 

Checking geometry... 

    Overall domain bounding box (-1.00386 -1.00391 0) (7.00386 7.00391 

3.99987) 

    Mesh (non-empty, non-wedge) directions (1 1 1) 

    Mesh (non-empty) directions (1 1 1) 

    Boundary openness (-5.93818e-17 -1.84773e-16 3.63569e-16) OK. 

    Max cell openness = 2.50477e-16 OK. 

    Max aspect ratio = 11.0631 OK. 

    Minimum face area = 0.000290858. Maximum face area = 0.307806.  Face 

area magnitudes OK. 

    Min volume = 2.93306e-05. Max volume = 0.175793.  Total volume = 

129.341.  Cell volumes OK. 

    Mesh non-orthogonality Max: 44.2681 average: 8.02187 

    Non-orthogonality check OK. 

    Face pyramids OK. 

    Max skewness = 2.1956 OK. 

    Coupled point location match (average 0) OK. 

 

Mesh OK. 

snappyHexMesh cfMesh 
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商用ソルバーへの変換 

cfMesh foamMeshToFluent FLUENT 

STARCCM+ 

OpenFOAM 

*.msh 

3DCAD 

※ポリヘドラルメッシュが含まれる
場合は一般的なメッシャーでは読
み込めない場合がある 
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Patch名を修正する 

#!/bin/sh  

 

sed -i -e "s/empty/patch/g" $1  

sed -i -e "s/empty/patch/g" mesh.fms 

emptyTopatch 

emptyをpatchに変更するスクリプト例 

sedコマンドを利用 

mesh.fms内の文字列“empty”を検索
し”patch”に置き換える 

-iをつけることでmesh.fmsを上書きする 

$./emptyTopatch mesh.fms 

$1とすることで引数を受け取る 
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meshDictで設定できる項目 
FoamFile  

{  

    version   2.0;  

    format    ascii;  

    class     dictionary;  

    location  "system";  

    object    meshDict;  

}  

 

 

maxCellSize 20.0;  

 

boundaryCellSize 1.0;  

 

minCellSize 10.0;  

 

surfaceFile        "mesh.fms";  

 

boundaryLayers  

{  

}  

 

localRefinement  

{  

}  

 

objectRefinements  

{  

}  

固定記述 

最大セルサイズ（絶対値でサイズを指定する） 
境界層セルサイズ 

最小セルサイズ 

 

形状ファイル stlまたはfms 

 

境界層の設定 

 

Patch名によるサイズ設定 

 

オブジェクトによるサイズ設定 

※最大セルサイズが基準と
なり、それ以降は指定した
値より小さいサイズになる 
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boundaryLayersで設定できる項目 

boundaryLayers  

{  

 

maxFirstLayerThickness        0.5;  

nLayers        3;  

thicknessRatio        1.2;  

 

    patchBoundaryLayers  

    {  

 

        patch1 

        {  

             maxFirstLayerThickness        0.1;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

 

        patch2 

        {  

             maxFirstLayerThickness        0.1;  

             nLayers        3;  

             thicknessRatio        1.2;  

        }  

    }  

}  

境界層の設定 

すべての表面から境界層を作成する場合 

第1層の最大厚さ 

層数 

成長率 

各patchに境界層を作成する場合 

第1層の最大厚さ 

層数 

成長率 
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localRefinement で設定できる項目 

localRefinement  

{  

 

    patch1 

    {  

        cellSize        0.25;  

       additionalRefinementLevels        1;  

    }  

 patch2 

    {  

        cellSize        0.125;  

        additionalRefinementLevels        2;  

    }  

｝ 

各patchによるセルサイズの指定 

セルサイズ 

or 

リファイメントレベル 
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objectRefinementsで設定できる項目 

objectRefinements  

{  

    ear1  

    {  

        cellSize 3.75;  

        type cone;  

        p0   (-100 1873 -320);  

        radius0  200;  

        p1   (-560 1400 0);  

        radius1   200;  

    }  

    tail  

    {  

        cellSize 3.75;  

        type box;  

        centre  (500 500 150);  

        lengthX  100;  

        lengthY  150;  

        lengthZ  200;  

    }  

    insideTheBody  

    {  

        cellSize 3.75;  

        type sphere;  

        centre  (0 700 0);  

        radius  50;  

    }  

 muzzlePiercing  

    {  

        cellSize 3.75;  

        type line;  

        p0      (-750 1000 450);  

        p1      (-750 1500 450);  

    }  

}  

セルサイズ 

円錐形状 

中心点 

半径の長さ 

オブジェクトによるサイズ指定 

セルサイズ 

矩形形状 

中心点 

各辺の長さ 

セルサイズ 

球形状 

中心点 

半径の長さ 

セルサイズ 

ライン 

始点 

終点 
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